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DISCLAIMER

All rights reserved. Information, technical data and tutorials contained in this document are proprietary under copyright law 
of  MicroEJ S.A. Without written permission from MicroEJ S.A., copying or sending parts of the document or the entire document 
by any means to third parties is not permitted. Granted authorizations for using parts of the document or the entire document 

do not mean MicroEJ S.A. gives public full access rights.

The information contained herein is not warranted to be error-free.

MicroEJ® and all relative logos are trademarks or registered trademarks of MicroEJ S.A. in France and other Countries.

Other trademarks are proprietary of their respective owners.
Java  is Sun Microsystems’ trademark for a technology for developing application software and deploying it in cross-platform, networked environments. When it is used in this site without adding the “ ” symbol, it includes 

implementations of the technology by companies other than Sun. Java , all Java-based marks and all related logos are trademarks or registered trademarks of Sun Microsystems Inc, in the United States and other Countries.
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• Goal:

o Provide an overview of the development tools provided to developers to debug an 
application

o Illustrate the use of the development tools

• Development tools categories:

o Runtime & Post-Mortem Debugging Tools

o Memory Inspection Tools (debug memory corruption, leaks)

o Static Analysis Tools

• The following icons are used in the next slides:

o : tool only working on Simulator

o : tool only working on the Device

o No icon means that the tool is working on the Device and on the Simulator.

o : This checkmark means the tool will be presented in this training.

V3.4 Sept. 2025© MICROEJ 2025

OVERVIEW
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DEVELOPMENT TOOLS OVERVIEW
TOOLS RUNTIME & POST-

MORTEM
MEMORY INSPECTION STATIC ANALYSIS TOOLS GUI DEBUGGING TOOLS

Core Engine VM Dump 

Debug on Device

Debug on Simulator

Port Qualification Tool (PQT)

SystemView 

Logging & Message Libraries

Code Coverage

Memory Map Analyzer

Heap Dumper / Analyzer

Heap Usage Monitoring

Core Engine MEMORY integrity check

SonarQube / Klocwork (Java/C)

Null Analysis

UI Flush Visualizer

UI MWT & Widget Debug Utilities
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Hardware required:

• NXP i.MX RT1170 Evaluation Kit (EVKB) + micro-USB cable + RK055HDMIPI4MA0 display panel

• More information about the Evaluation Kit: NXP i.MX RT1170 User Manual

Environment Setup:

• Follow the NXP i.MX RT1170 Evaluation Kit Getting Started to setup your environment and 
run a demo application on the Virtual Device and on the i.MX RT1170 Evaluation Kit.

• Note: the next slides are using IntelliJ IDEA with MicroEJ plugin for IntelliJ IDEA 1.3.1. This training 
supports all other available IDEs (Android Studio, VS Code, …)

This training requires the Getting Started to be completed until the 
Run an Application on the i.MX RT1170 Evaluation Kit section (included).
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PREREQUISITES

The path to the NXP i.MX RT1170 VEE Port sources 
should be as short as possible and contain no 
whitespace or non-ASCII character.

https://www.nxp.com/part/RK055HDMIPI4MA0
file:///C:/Users/acolleux/Downloads/MIMXRT1170EVKBHUG-1.pdf
https://docs.microej.com/en/latest/SDK6UserGuide/gettingStartedIMXRT1170.html#sdk-6-getting-started-imxrt1170
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GET TRAINING RESOURCES

• Download and extract the training resources provided with this training, it should contain:

o example-java-widget/

o fill-array-mock/

o slide-container/

o fill_array_heap_corruption.c

o jdwp-server-1.0.4.jar

V3.4 Sept. 2025© MICROEJ 2025

ENVIRONMENT SETUP (1/5)
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OPEN THE EXAMPLE-JAVA-WIDGET PROJECT

• Open IntelliJ IDEA.

• If no project is opened in your IDE yet, 
click on Open.
Otherwise, go to File > Open.

• Browse to the VEE Port sources folder:
example-java-widget

• Click on OK.

• The project sources appear in the Projects view.

V3.4 Sept. 2025© MICROEJ 2025

ENVIRONMENT SETUP (2/5)



8

VEE PORT SELECTION

• Get the path to the NXP i.MX RT1170 VEE Port (e.g. C:\workspaces\training\nxpvee-mimxrt1170-
evk\nxpvee-mimxrt1170-evk)

• Add the path to the VEE Port in the settings.gradle.kts file of the example-java-widget project:

• In the build.gradle.kts file of the example-java-widget project, add the dependency to the VEE Port:

• Reload the Gradle project to see the NXP i.MXRT1170 VEE Port project in the IDE:
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ENVIRONMENT SETUP (3/5)

rootProject.name = “widget-examples"
includeBuild("C:\\workspaces\\training\\nxpvee-mimxrt1170-evk\\nxpvee-mimxrt1170-evk")

dependencies {
    implementation("ej.api:edc:1.3.5")

    //Uncomment the microejVee dependency to set the VEE Port or Kernel to use
    microejVee("com.nxp.vee.mimxrt1170:vee-port:3.0.0")
}
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ADD CUSTOM MOCK

A native function needs to be implemented in a mock to run the sample with the simulator:

• The mock is automatically built and added to the VEE port through a Gradle dependency in application 
project.
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ENVIRONMENT SETUP (4/5)
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ADD CUSTOM NATIVE FUNCTION

A native function needs to be implemented in the BSP to run the sample on the device:

• Copy/Paste fill_array_heap_corruption.c in the BSP project (e.g. copy it in nxpvee-mimxrt1170-evk 
/bsp/vee/src/main).

• Add it to CMakeLists.txt (nxpvee-mimxrt1170-evk/bsp/vee/scripts/armgcc/CMakeLists.txt):
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ENVIRONMENT SETUP (5/5)
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Run the sample on the Simulator and on the Device to make sure that the setup is correct:

V3.4 Sept. 2025© MICROEJ 2025

CHECK THE ENVIRONMENT SETUP

• Go to the Gradle tasks view

• Run the runOnSimulator task:

• Run the runOnDevice task. Make sure the hardware is 
properly setup (cf. Prerequisites)
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Example-Java-Widget
Overview

Introduction to the 
Example-Java-Widget 
project

V3.4 Sept. 2025© MICROEJ 2025
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This project is a fork of 
Example Widget 8.1.0, bugs have been 
explicitly added.

The next slides will present those bugs 
and explain how to fix them.

V3.4 Sept. 2025© MICROEJ 2025

GUI OVERVIEW
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The application is composed of the following packages:

• Animated image: provides a page with an animated image widget 
producing a GUI freeze

• Carousel: typical page without bugs

• Circular Dotted Progress: provides a page that produces a memory 
leak

• Circular Slider: provides a page having a rendering issue

• Common: provides a navigation framework and common resources 
used by the application

• Main: main page of the application

• Radio Button: provides a page generating a heap memory corruption

Each package contains:

• A  Page class, describing the layout of the page

• A Widget package containing the widgets of the page

V3.4 Sept. 2025© MICROEJ 2025

PROJECT STRUCTURE
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Debug the 
BSP C Code

Start a Debug Session in VS 
Code

V3.4 Sept. 2025© MICROEJ 2025
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This section describes how to debug C code running on the NXP i.MXRT1170 using Visual Studio 
Code and GDB.

This section is not MicroEJ specific.

A GDB debugger will be required in the next slides.
You can skip those slides if you already have a GDB client working to debug the NXP 
i.MXRT1170.

Requirements:

• Install Visual Studio Code (https://code.visualstudio.com/)

• In VS Code, install the MCUXpresso extension for VS Code:

V3.4 Sept. 2025© MICROEJ 2025

OVERVIEW

https://code.visualstudio.com/
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• Enable the DEBUG mode by setting CHOSEN_MODE in nxpvee-mimxrt1170-
evk\bsp\vee\scripts\set_project_env.bat:

V3.4 Sept. 2025© MICROEJ 2025

ENABLE THE DEBUG MODE
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SELECT THE DEBUG BUILD MODE

VS Code allows to build, flash and debug embedded projects.

Open the NXP i.MX RT1170 VEE Port project in VS Code:

• In VS Code, go to File > Open Folder...

• Browse to the VEE Port sources folder:
nxpvee-mimxrt1170-evk

• Click on OK.

Once the project is opened:

• Open the MCUXpresso plugin view.

• Open the Build Configurations section in the PROJECTS view.

• Set flexspi_nor_sdram_debug_evkb as the default build 
configuration.

V3.4 Sept. 2025© MICROEJ 2025

BSP DEBUGGING IN VS CODE (1/2)
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With your project still in VSCode the project is opened:

• Open the MCUXpresso plugin view.

• Right-click on the project.

• Select Debug (as the application is 
already running on the device).

V3.4 Sept. 2025© MICROEJ 2025

BSP DEBUGGING IN VS CODE (2/2)
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The debug view opens and the application runs on the device:
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DEBUG VIEW IN VS CODE

A control bar is 
available to 

start/stop/pause 
the debugging

The Debug Console allows to 
type GDB commands

Refer to VS Code 
documentation for more 

information.

https://code.visualstudio.com/docs/cpp/cpp-debug#_gdb-lldb-and-lldbmi-commands-gdblldb
https://code.visualstudio.com/docs/cpp/cpp-debug#_gdb-lldb-and-lldbmi-commands-gdblldb
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In case of connection issue to the target, reset the debug 
probe selection via the MCUXpresso plugin:

• Select the MCUXpresso plugin in the left banner.

• Right-click on the project name and select Reset Probe 
Selection.

• Start the debug again.

If the issue persists, unplug/plug the USB cable and turn 
OFF/ON the device:

V3.4 Sept. 2025© MICROEJ 2025

TROUBLESHOOTING
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Runtime & 
Post-Mortem 

Debugging Tools

Debug the Application code

V3.4 Sept. 2025© MICROEJ 2025
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• Tools:
o Core Engine VM Dump

o Debug on Device

o Debug on Simulator

o Port Qualification Tools (qualify a VEE Port)

o Event Tracing & Logging*

o Code Coverage*

• Example:

o Debug a deadlock in an application in the 
Simulator and on Device

V3.4 Sept. 2025© MICROEJ 2025

RUNTIME & POST-MORTEM DEBUGGING TOOLS

GUI freeze when entering a page
* Tool not introduced in this presentation, visit docs.microej.com for more information.

https://docs.microej.com/en/latest/VEEPortingGuide/coreEngine.html#vm-dump
https://docs.microej.com/en/latest/VEEPortingGuide/coreEngine.html#vm-dump
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#debug-on-device
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#debug-on-device
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#debug-on-simulator
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#debug-on-simulator
https://docs.microej.com/en/latest/VEEPortingGuide/veePortQualification.html
https://docs.microej.com/en/latest/VEEPortingGuide/veePortQualification.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/codeInstrumentationForLogging.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/codeInstrumentationForLogging.html
https://docs.microej.com/en/latest/SDKUserGuide/codeCoverageAnalyzer.html
https://docs.microej.com/en/latest/SDKUserGuide/codeCoverageAnalyzer.html
https://docs.microej.com/en/latest/
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REPRODUCE THE ISSUE

• Run the example-java-widget project the on 
Device:

• Enter the Animated Image page.

The GUI should freeze after the screen transition:

V3.4 Sept. 2025© MICROEJ 2025

DEBUG A DEADLOCK IN AN APPLICATION
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• Core Engine VM Dump is a diagnose tool to investigate unexpected behavior occurring on 
the target.

• When?
o Call the LLMJVM_dump() method in the Core Engine task at runtime to diagnose unexpected 

behavior (ex: UI freeze).

o Call the LLMJVM_dump() as a last resort in a fault handler to get a snapshot of the Core Engine, to 
check if the issue comes from a LLAPI or the underlying C code.

• What?
o Prints the state of the MicroEJ Core Engine to the standard output stream.

o For each Java thread, the Java stack trace, the name, the state and the priority are printed.

• Requirements:
o A way to read stdout (usually UART).

V3.4 Sept. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (1/4)

https://docs.microej.com/en/latest/PlatformDeveloperGuide/platformConcepts.html#principle
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• Trigger the LLMJVM Dump from the 
debugger (see next slide):

HOW-TO?

• Example of LLMJVM Dump triggered from a 
fault handler:

V3.4 Sept. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (2/4)
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TRIGGER THE LLMJVM DUMP FROM THE DEBUGGER (VS CODE / GDB)

• Start a serial terminal to get the application execution traces

• Start the debug session in VS Code

• Click the “Play” button to start the application

• Enter the Animated Image page

• Click the “Pause” button

• Run the following command in the Debug Console:

• Click the “Play” button to resume the execution at the set symbol, the VM dump can be see in the serial terminal
V3.4 Sept. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (3/4)

set $pc = __icetea__virtual__com_is2t_microjvm_IGreenThreadMicroJvm___dump
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=================================== VM Dump ====================================
Java threads count: 3
Peak java threads count: 3
Total created java threads: 4
Last executed native function: 0x9014DDFB
Last executed external hook function: 0x00000000
State: idle, not notified
--------------------------------------------------------------------------------
Java Thread[1794]
name="Thread1" prio=5 state=MONITOR_QUEUED max_java_stack=492 current_java_stack=183
Locked on: java/lang/Object@0xC0081C4C (owned by thread[1281])

java/lang/Thread@0xC0082150:
    at com/microej/demo/widget/animatedimage/widget/AnimatedImage$1.run(AnimatedImage.java:190)
        Object References:
            - com/microej/demo/widget/animatedimage/widget/AnimatedImage$1@0xC00821B0
            - java/lang/Object@0xC0081C48
            - java/lang/Object@0xC0081C4C

--------------------------------------------------------------------------------
Java Thread[1281]
name="UIPump" prio=5 state=MONITOR_QUEUED max_java_stack=1296 current_java_stack=850
Locked on: java/lang/Object@0xC0081C48 (owned by thread[1794])

java/lang/Thread@0xC008047C:
    at com/microej/demo/widget/animatedimage/widget/AnimatedImage.renderContent(AnimatedImage.java:233)
        Object References:
            - com/microej/demo/widget/animatedimage/widget/AnimatedImage@0xC0081C2C
            - ej/microui/display/GraphicsContext@0xC008042C
            - java/lang/Object@0xC0081C4C
            - java/lang/Object@0xC0081C48

EXAMPLE OF DUMP

• Use the Stack Trace Reader to decode 
the stack trace

• A dead lock is identified in the stack 
trace, lock between threads “Thread1” 
and “UI Pump”

• The UI Tread (UI Pump) is locked
→ GUI Freeze

V3.4 Sept. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (4/4)

https://docs.microej.com/en/latest/SDKUserGuide/stackTraceReader.html
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DEBUG ON SIMULATOR

• Use of JDWP (Java Debug Wire Protocol) to use 
Eclipse debugger

• Use mocks to simulate and debug corner cases 
of the target

• Debugger features:

o Breakpoints

o Step-by-step execution

o Variables and fields value monitoring

o Thread execution stacks list

DEBUG ON DEVICE

• Use of JDWP (Java Debug Wire Protocol) to use 
Eclipse debugger

• Need to setup the VEE Debugger Proxy

• Postmortem debug from a snapshot of the 
memory

• Debugger features:

o Breakpoints

o Step-by-step execution (planned)

o Variables and fields value monitoring

o Thread execution stacks list

V3.4 Sept. 2025© MICROEJ 2025

SIMULATOR & DEVICE DEBUGGER

Note: import the Foundation Library Sources to the debugger to get the exact source code which 
is executed. 

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#foundation-library-sources
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Debug on Device

Debug the Application Code 
on the Device

V3.4 Sept. 2025© MICROEJ 2025
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The VEE Debugger Proxy is an implementation of the Java Debug Wire protocol (JDWP) for 
debugging Applications executed by MICROEJ VEE. 

• VEE Debugger Proxy principle:

• Available since Architecture 8.1

V3.4 Sept. 2025© MICROEJ 2025

VEE DEBUGGER PROXY PRINCIPLE

• No VEE Port update required

• Steps:

1. Generate a VEE memory dump script for the 
target / toolchain 

2. Run the application Executable on target

3. Dump the memory of the running Executable 
using the C Debugger using the VEE memory 
dump script

4. Run the VEE Debugger Proxy in a Command 
Prompt

5. On the MicroEJ Simulator, run a Remote Java 
Application Debugging session

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
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• The VEE Debugger Proxy tool jdwp-server-1.0.4 
is required to generate the VEE memory dump 
script. 
The tool is provided in the training package.

• The example-java-widget project provides the 
generateDumpScript task that allows the user 
to generate the VEE memory dump script:

This task is declared in the build.gradle.kts, it is 
based on the command line provided in the VEE 
Debugger Proxy documentation:

Note that this task is configured to generate a GDB 
dump script.

V3.4 Sept. 2025© MICROEJ 2025

GENERATE THE VEE MEMORY DUMP SCRIPT (1/2)

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
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Run the generateDumpScript task:

• The application is built and flashed on the device,

• The dump script is generated in the build/generated folder:

V3.4 Sept. 2025© MICROEJ 2025

GENERATE THE VEE MEMORY DUMP SCRIPT (2/2)
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• Once the vee-memory-dump.gdb file is generated, open VS Code.

• Attach to the device in VS Code (cf. Debug the BSP C Code).

V3.4 Sept. 2025© MICROEJ 2025

DUMP THE DEVICE MEMORY (1/3)
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• To make sure that the Core engine is not running when the dump is performed, it is 
recommended to create a breakpoint at a specific safe point (Core Engine hooks or native 
function).

• Otherwise, make sure that the Core engine is not running when pausing the debugger (see 
Call Stack section in VS Code):

V3.4 Sept. 2025© MICROEJ 2025

DUMP THE DEVICE MEMORY (2/3)

Core Engine 
is running

Core Engine is 
NOT running

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html#with-gnu-debugger-gdb
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3. Heap dumps are generated in the 
output folder:

Note: the output folder is specified 
when generating the vee-memory-
dump.gdb script.

In VS Code, run the vee-memory-dump.gdb script file to dump 
the memory:

1. Pause the debugger:

2. Run the following command in the Debug Console view:

V3.4 Sept. 2025

DUMP THE DEVICE MEMORY (3/3)

source C:/[YOUR_PATH]/vee-memory-dump.gdb

© MICROEJ 2025  Be aware of the separator used.
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The example-java-widget project provides the 
generateDumpScript task that allows the user to 
run the VEE debugger proxy:

This task is declared in the build.gradle.kts, it is 
based on the command line provided in the VEE 
Debugger Proxy documentation:

The tool takes the dumped .hex files as input.

V3.4 Sept. 2025© MICROEJ 2025

RUN THE VEE DEBUGGER PROXY (1/2)

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
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Run the runVeeDebuggerProxy task:

• The tool is launched in the console:

V3.4 Sept. 2025© MICROEJ 2025

RUN THE VEE DEBUGGER PROXY (2/2)
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In IntelliJ IDEA:

• Click on Run > Edit Configurations….

• Click on + button (Add New 
Configuration).

• Select Remote JVM Debug.

• Click on the New launch configuration 
button.

• Give a name to the launcher in the Name 
field.

• Set the debug host to localhost and port 
to 8000.

• Click on the Debug button.

V3.4 Sept. 2025© MICROEJ 2025

RUN A REMOTE JAVA APPLICATION DEBUG SESSION
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Click on the pause button and the following debug state and the thread call stack can be seen:

V3.4 Sept. 2025© MICROEJ 2025

GET THE POST-MORTEM DEBUGGING STATE (1/2)
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The 2nd Thread state can also be seen:

V3.4 Sept. 2025© MICROEJ 2025

GET THE POST-MORTEM DEBUGGING STATE (2/2)
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Debug on Simulator

Debug the Application Code 
on the Simulator

V3.4 Sept. 2025© MICROEJ 2025
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• Execute the runOnSimulator Gradle task with the following options:

• The console opens with the following message, click on Attach debugger to start the debug session:

V3.4 Sept. 2025© MICROEJ 2025

DEBUG ON THE SIMULATOR (1/2)

-P"debug.mode"=true -P"debug.port"=8000
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• Pause the Debugger once the freeze occurs.

• The same state that the debug on device view can be seen

V3.4 Sept. 2025

DEBUG ON THE SIMULATOR (2/2)

© MICROEJ 2025
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The interlock is caused by the synchronization of resource1 and resource2 objects on 2 different 
Threads:

• The renderContent method is called in the UIPump thread context

• Note: this method is called at every animation frame of the animated image

• The onShown method creates a TimerTask that is executed in the context of the Timer thread

• Note: this method is called once, when the Animated Page is shown

Fix: this code has been written for training purpose,
remove it to unlock the application.

V3.4 Sept. 2025© MICROEJ 2025

ISSUE ANALYSIS & FIX
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VEE Port Qualification Tool

V3.4 Sept. 2025© MICROEJ 2025
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• The VEE Port Qualification Tool (PQT) project provides the tools 
required to validate each component of a MicroEJ VEE Port. 

• After porting or adding a Foundation Library to a MicroEJ VEE 
Port, it is necessary to validate its integration.

• For each Low Level API, an Abstraction Layer implementation is 
required. The validation of the Abstraction Layer implementation 
is performed by running tests at two-levels:

o In C, by calling Low Level APIs (usually manually).

o In Java, by calling Foundation Library APIs (usually automatically 
using Platform Test Suite).

• PQT tests can be extended by the developer to support custom 
Foundation Libraries.

• Please refer to the Platform Qualification documentation for more 
information.

V3.4 Sept. 2025© MICROEJ 2025

VEE PORT QUALIFICATION TOOL (1/3)

https://docs.microej.com/en/latest/glossary.html#term-Foundation-Library
https://docs.microej.com/en/latest/PlatformDeveloperGuide/platformQualification.html#platform-testsuite
https://docs.microej.com/en/latest/PlatformDeveloperGuide/platformQualification.html#platform-qualification
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• PQT tests are provided with a Test Suite 
project, to run tests automatically (CI or 
locally) 
→ Agility in the development flow

• A Test Suite contains one or more tests. 
For each test, the Test Suite Engine will:

o Build a MicroEJ Firmware for the test.

o Program and Run the MicroEJ 
Firmware onto the device.

o Retrieve the execution traces.

o Analyze the traces to determine 
whether the test has PASSED or 
FAILED.

o Append the result to the Test Report.

o Repeat until all tests of the Test Suite 
have been executed.

V3.4 Sept. 2025© MICROEJ 2025

VEE PORT QUALIFICATION TOOL (2/3)

VEE Port Testsuite on Device Overview
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• The VEE Port Template GitHub repository holds the configuration necessary to pass tests on VEE ports:

• https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation

• The validation folder provides configuration files for each test suite.

• Execute the test Gradle task on the Test Suite Project either in Command Line or via the IDE to launch the 
corresponding test suite.

V3.4 Sept. 2025© MICROEJ 2025

VEE PORT QUALIFICATION TOOL (3/3)

https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
https://github.com/MicroEJ/Tool-Project-Template-VEEPort/tree/master/vee-port/validation
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1. PQT: validate the vertical integration: Foundation Library > Abstraction Layer > C Library > 
Driver

2. Event Tracing & Logging: instrument the application with debug logs

3. Core Engine VM Dump: diagnosis tool to display the state of the MicroEJ Runtime and the 
MicroEJ threads on target (name, priority, stack trace, etc. )

4. Debugger (on device & simulator): analysis of an applicative issue

V3.4 Sept. 2025© MICROEJ 2025

KEY TAKEWAYS
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Memory Inspection 
Tools

V3.4 Sept. 2025© MICROEJ 2025
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• Tools:
o Memory Map Analyzer*

o Heap Dumper & Heap Analyzer

o Core Engine Memory integrity check

o Heap Usage Monitoring Tool*

• Examples:

o Investigate memory leaks

o Detect memory corruption of the 
Core Engine heap

V3.4 Sept. 2025© MICROEJ 2025

MEMORY INSPECTION TOOLS

Out Of Memory exception in a GUI 
application

* Tool not introduced in this presentation, visit docs.microej.com for more information.

https://docs.microej.com/en/latest/SDK6UserGuide/memoryMapAnalyzer.html
https://docs.microej.com/en/latest/SDK6UserGuide/memoryMapAnalyzer.html
https://docs.microej.com/en/latest/SDKUserGuide/heapAnalyzer.html
https://docs.microej.com/en/latest/SDKUserGuide/heapAnalyzer.html
https://docs.microej.com/en/latest/VEEPortingGuide/coreEngine.html#check-internal-structure-integrity
https://docs.microej.com/en/latest/VEEPortingGuide/coreEngine.html#check-internal-structure-integrity
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/heapUsageMonitoring.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/heapUsageMonitoring.html
https://docs.microej.com/en/latest/
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PRINCIPLE

When the Executable of an Application is built, a 
Memory Map file is generated:

This file can be visualized with the Memory Map 
Analyzer, an Eclipse IDE plugin. It displays the 
memory consumption of different features in the 
RAM and ROM.

USAGE

.map files can be opened using the Memory Map Analyzer plugin. 
Make sure the Eclipse IDE is installed with the required plugin, 
then launch it. 

• In Eclipse IDE, click on File > Open File… to open the .map file:

Note: it does not include the memory usage of the BSP project 
(or MicroEJ native code). Only the content of microejapp.o is 
displayed.
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MEMORY MAP ANALYZER

https://docs.microej.com/en/latest/SDK6UserGuide/tools.html#sdk6-microejtools
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• Heap Dumper is a tool that takes a snapshot of the heap. 
Generated files (.heap extension) are available in the application output folder.

• Heap Analyzer is a tool that allows to inspect the heap dumps. 
It provides the following features:

o Memory leaks detection

o Objects instances browse

o Heap usage optimization (using immortal or immutable objects)

o Comparison between Heap Dumps

• To generate .heap dump files, System.gc() must be called explicitly in the application code.

• .heap dump files can be generated in simulation and also dumped from the device.
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HEAP DUMPER & HEAP ANALYZER (1/8)
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USAGE

Heap Dumper is a tool that allows to get a snapshot of the 
heap of an Application running on the Simulator or on a 
device.

To run the Heap Dumper on Simulator (IntelliJ IDEA / 
Android Studio):

• Right-Click on the runOnSimulator task.

• Click on Modify Run Configuration...

• Add the following option:

• Click on Run.

Or use this command line:
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HEAP DUMPER & HEAP ANALYZER (2/8)

-D"microej.option.s3.inspect.heap=true"

.\gradlew.bat runOnSimulator 
-D"microej.option.s3.inspect.heap=true"

Run Configuration options
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REPRODUCE THE ISSUE

• Once the Simulator is started, enter / leave the 
Circular Dotted Progress page
~10 times

• Get the error trace in the console:

• Close the Simulator.

• Heap Dumps are generated in the 
build/output/<fqnMainClass>/heapDump/ folder of the project, where 
<fqnMainClass> is the Fully Qualified Name of the Application Main class.
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HEAP DUMPER & HEAP ANALYZER (3/8)

Generated Heap 
Dump files
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IMPORT THE HEAP DUMPS

Heap Dumps can be opened using the Heap Analyzer plug-in. Make sure the Eclipse IDE is installed with 
the required plugin, then launch it. 

In Eclipse IDE, create a new empty Project:

• Go to File > New > Project…

• Select General > Project.

• Give it a name and click Finish.

• Copy paste the generated Heap Dumps into this project:
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HEAP DUMPER & HEAP ANALYZER (4/8)

https://docs.microej.com/en/latest/SDK6UserGuide/tools.html#sdk6-microejtools
https://docs.microej.com/en/latest/SDK6UserGuide/tools.html#sdk6-microejtools
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PROGRESSIVE HEAP USAGE ANALYSIS

The progressive heap usage tool allows to see the number 
of instances over time.
To use the tool:

• Select the last .heap file (e.g. heap-5.heap)

• Right-click on it and select
Heap Analyzer > Show progressive heap usage

The following view opens:

In the Threads tab, we can clearly notice that the memory 
leak is coming from the UIThread:

Browsing the types, we notice that the instances of some 
types are also growing (e.g. TimerTaskList):

Next step: compare 2 consecutive heap dumps focusing 
the types that are growing continuously.
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HEAP DUMPER & HEAP ANALYZER (5/8)
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COMPARE THE HEAP DUMPS

• Right-Click on 2 consecutive .heap files.
Preferably the ones generated just before the Out Of Memory error.

• Click on Compare With → Each Other.

• The Heap Viewer opens, select the following configuration:
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HEAP DUMPER & HEAP ANALYZER (6/8)
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• Heap Compare between .heap-3 and .heap-4:

Guidelines:

• Lots of new objects have been 
created (691 new instances)

• Use the compare by content 
option to discard objects that 
moved but have the same content

• Look for new objects that can have 
an impact (Thread, Timer, Page, 
Widget, StyleSheet) 

→ knowledge of the application 
required, need to understand the 
objects hierarchy

• Once an object has been picked, 
look its parent in the Instance 
Browser
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HEAP DUMPER & HEAP ANALYZER (7/8)

New Timer Instance referenced from 
AnimatedCircularDottedProgress 

class 
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• New Timer instance created each time the 
CircularDottedProgressPage is shown:

→ Memory leak is due to the useless Timer 
instances keeping a reference on the widget 
AnimatedCircularDottedProgress
Also, the TimerTask is never canceled

ROOT CAUSE ANALYSIS FIX

• Retrieve a global Timer instance (defined at 
application startup)

• Cancel the TimerTask once the 
CircularDottedProgressPage is hidden
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HEAP DUMPER & HEAP ANALYZER (8/8)

@Override
protected void onShown() {
    System.gc();
    this.startTime = Util.platformTimeMillis();
    final AnimatedCircularDottedProgress progress = this;
    Timer timer = ServiceFactory.getService(Timer.class, Timer.class);
    this.task = new TimerTask() {

       @Override
       public void run() {
          progress.tick();
       }
    };
    timer.schedule(this.task, 0, 100);
}

@Override
protected void onHidden(){
    if(this.task != null){
       this.task.cancel();
    }
    this.task = null;
}
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• The LLMJVM_checkIntegrity API checks the internal memory structure integrity of the Core Engine 
with the LLMJVM_checkIntegrity API to detect memory corruptions in native functions. 

• This feature is for Applications deployed on hardware devices only:

o If an integrity error is detected, the LLMJVM_on_CheckIntegrity_error hook is called and this 
method returns 0.

o If no integrity error is detected, a non-zero checksum is returned.

• Note: this function affects performance and should only be used for debug purpose.
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CORE ENGINE MEMORY INTEGRITY CHECK (1/3)

https://docs.microej.com/en/latest/PlatformDeveloperGuide/coreEngine.html#core-engine-check-integrity
https://docs.microej.com/en/latest/PlatformDeveloperGuide/coreEngine.html#core-engine-check-integrity
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REPRODUCE THE ISSUE

• Run the example-java-widget application on the device

• Enter the Radio Button page, click on one of the buttons

• The GUI should freeze, the Heap is corrupted

• Run the BSP Debug, the execution is stuck in a while loop because the CRC check of the VEE Heap failed:
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CORE ENGINE MEMORY INTEGRITY CHECK (2/3)
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ROOT CAUSE ANALYSIS

• The fillArrayDo native function writes outside 
the array memory area:

FIX

• Fix the implementation of fillArrayDo.
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CORE ENGINE MEMORY INTEGRITY CHECK (3/3)

void fillArrayDo(uint8_t * array, jint length){
 *(array-=2)=1; // Write outside of the array

}

void Java_com_microej_demo_widget_radiobutton_widget_RadioButton_fillArray(uint8_t * array, jint length){

 int32_t crcBefore = LLMJVM_checkIntegrity();
 fillArrayDo(array, length);
 int32_t crcAfter = LLMJVM_checkIntegrity();
 if(crcBefore != crcAfter){
    // Corrupted MicroJVM virtual machine internal structures
    while(1);
 }

}
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• Heap Dumper:

• Generates heap dumps (.heap file) on System.gc() execution

• Heap Analyzer features:

• Compare: compares two heap dumps, showing which objects were created, or garbage 
collected, or have changed values 
→ useful for memory leaks detection

• Heap Viewer: shows which instances are in the heap, when they were created, and attempts to 
identify problematic areas 
→ useful for memory optimization

• Core Engine Memory Integrity Check: detect memory corruptions in native functions.

• Heap Usage Monitoring Tool: estimate the heap requirements of an application.
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KEY TAKEWAYS
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Static Analysis 
Tools

V3.4 Sept. 2025© MICROEJ 2025



67

NULL ANALYSIS

Static analysis tools are helpful allies to prevent several classes of bugs.

• Use the Null Analysis tool to detect and prevent NullPointerException, one of the most common causes 
of runtime failure of Java programs.
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STATIC ANALYSIS TOOLS (1/3)

https://docs.microej.com/en/latest/SDK6UserGuide/nullAnalysis.html
https://repository.microej.com/javadoc/microej_5.x/apis/java/lang/NullPointerException.html
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SONARQUBE

• SonarQube  is an open source platform for continuous inspection of code quality. SonarQube offers 
reports on duplicated code, coding standards, unit tests, code coverage, code complexity, potential 
bugs, comments, and architecture.

• SonarQube can be integrated with CI tools to monitor code quality during the project life.

• To set it up on your MicroEJ application project, please refer to this documentation. (configures the set 
of rules relevant to the context of MicroEJ Application development)
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STATIC ANALYSIS TOOLS (2/3)

SonarQube code analysis 
performed inside Eclipse IDE

SonarQube code analysis 
performed on SonarQube server

https://docs.microej.com/en/latest/Tutorials/tutorialImproveCodeQuality.html#sonar-code-analysis
https://docs.microej.com/en/latest/Tutorials/tutorialImproveCodeQuality.html#sonar-code-analysis
https://docs.microej.com/en/latest/Tutorials/tutorialImproveCodeQuality.html#sonar-code-analysis
https://github.com/MicroEJ/ExampleTool-Sonar
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KLOCWORK

• Klocwork is another code analysis platform that 
can be integrated to MICROEJ SDK.
Documentation can be found here.

• Klocwork can be integrated with CI tools to monitor 
code quality during the project life.
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STATIC ANALYSIS TOOLS (3/3)

Klocwork code analysis performed on Klocwork 
server

Klocwork code analysis performed inside 
Eclipse IDE

https://docs.roguewave.com/en/klocwork/current/
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• UI specific tools are explained in Mastering UI Development Tools training course. It is 
tailored towards UI application debugging and improvements:

o GUI Performances Improvements (bottlenecks identification with SystemView)

o GUI Rendering Issues Debug

• While centered around a UI profiling use case, the SystemView training teaches skills that 
could be applied around debugging any performance issues.
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FOLLOW-UP: UI SPECIFIC TOOLS AND SYSTEMVIEW
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THANK  YOU  
f o r  y o u r  a t t e n t i o n  !
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